Creating grids (G07)

Creating a regular grid from a set of line or point data is a fundamental operation with geophysical data. The INTREPID Gridding tool is a powerful means for creating grids. This guided tour conducts you through a simple gridding operation, showing you how to create a grid from a set of line data.

The following illustration shows the final result of a gridding process in the Gridding tool window.

Overview

The Gridding tool enables you to produce a grid (raster) dataset from a field of a line or point (vector) dataset.

You can use the Gridding tool to produce grids from:

- Point data (e.g., gravity),
- Line data (e.g., aeromagnetics)

including both:

- Regularly spaced data (e.g., aeromagnetics) and
- Variable density sampled data (e.g., ground and marine gravity).

The INTREPID Gridding tool can:

- Create grids from point or line data using Minimum Curvature refinement
- Create grids from line data using Bicubic Splining interpolation
- Create grids from point or line Falcon and FTG gradient data using Spherical interpolation (SLERP) followed by MITRE refinement.
- Process very large datasets, using tiling if required
- Create multiband grids from several line or point dataset fields.
• Create a single grid from multiple input sources
• Create a single grid from many datasets (over 7000 datasets have been used to create one grid).

Gridded data form the basis for image-based enhancements such as:
• Spectral domain (FFT) and convolution filtering,
• Interpretation tools (Euler deconvolution, grid-based depth methods),
• Image-based hard copy products.

**Location of sample data for Guided Tours**

We provide two complete sets of sample datasets, one in INTREPID format and one in Geosoft format. INTREPID works equally well with both formats. When you want to open a dataset, navigate to the directory containing the required data format.

Where **install_path** is the path of your INTREPID installation, the project directories for the Guided Tours sample data are

**install_path\sample_data\guided_tours\intrepid_datasets** and
**install_path\sample_data\guided_tours\geosoft_datasets**.

For example, if INTREPID is installed in

C:\Program Files\Intrepid\Intrepid4.5.nnn,

then you can find the INTREPID format sample data at

C:\Program Files\Intrepid\Intrepid4.5.nnn\sample_data\guided_tours\intrepid_datasets

This is the default location for the sample data. If you have installed INTREPID normally, the data resides there. If you have installed INTREPID elsewhere, the exercises will work just as well. Just use the appropriate pathnames.

For more information about installing the sample data, see "Sample datasets—installing, locating, naming" in INTREPID Guided Tours Introduction (G01)

For a more detailed description of INTREPID datasets, see Introduction to the INTREPID database (G20). For even more detail, see INTREPID database, file and data structures (R05).

**Location of sample data for CookBooks**

Right next to the Guided tours data, is a rich set of more exotic geophysics datasets and grids, already prepared for the cookbook training sessions. A casual user might also gain some trial and error insights into the capabilities of the software, just by testing the Project Manager's ability to preview and describe the attributes of each of the cookbook datasets.

**Context of this guided tour**

**In the context of your data processing cycle**, gridding can be used at any stage to visualise data. It is particularly useful as a rapid means of assessing data quality.

**Should you complete this guided tour?**

This guided tour is intended for introductory level users and contains full detailed instructions. The gridding process it demonstrates is a fundamental INTREPID process. You should complete this tour as part of a thorough evaluation of INTREPID. In later guided tours you can use the Gridding tool to produce grids from
the results of the exercises you complete.

**What you will do**

**Flow Chart Summary**

- **Inputs**
  - Line dataset

- **Process**
  - Specify a "Z" field to grid
  - Configure gridding parameters

- **Outputs**
  - Grid dataset
Steps to follow

1. **Launch the Gridding Tool.**

   Start the Project Manager. Navigate to the directory `install_path\sample_data\guided_tours\intrepid_datasets`. From the Gridding Menu, launch Gridding. The INTREPID Gridding tool window appears.

   INTREPID displays the Gridding window with the Input tab. The **Input** tab is one of four, located near the top of the Gridding tool window.
2 Open the input dataset and field

Select the **Add** tab. The **Open Input Dataset** dialog box appears. Select the dataset **albury..DIR** and choose **Open**. **INTREPID** opens the dataset and displays a coloured thumb sketch of the line data in the **Input Vector Data** panel.

In the central panel, **INTREPID** displays the **X** and **Y** field alias names and their associated Datum and Projection.

Below **Y Field** is the **Data** field. This is the field that we use to create the grid. From the **Data** dropdown list, select the field **rawmag**.
3 Identify the traverse lines and the tie lines

When you create a grid from geophysical line data, it is normal to include the traverse lines and exclude the tie lines from the grid. The reason this is done, is that there can be residual location errors that might show up at the crossings of the lines, as small spikes. Better to avoid this. There are two ways of identifying traverse and tie lines.

- By **LineType**. This is a special INTREPID field which is set to 2 for traverse lines and 4 for tie lines.
- By **line bearing**. This is automatically calculated by INTREPID.

Whether you use LineType or line bearing to identify traverse and tie lines depends on what type of gridding algorithm you use.

- If you are using Nearest Neighbors filling and Minimum Curvature refinement you may use either LineType or line bearing as the line identifier.
- If you are using Bicubic Splining interpolation you must use line bearing as the line identifier.

The main thing to be aware of is that the LineType field must be created separately by you, using the spreadsheet editor, before the Gridding tool is used. However the Gridding tool is able to calculate the line bearing automatically.

For the albury data you are using, there is already a LineType field defined in the dataset, so you do not need to create one.

The default choice is **Acquisition Lines identified by LineType**. The dropdown list should already show **linetype** so you do not need to change this setting.

4 Select the gridding method

Select the **Gridding Method** tab. The **Gridding Method** dropdown list shows the different gridding methods available. For this exercise use **Nearest Neighbours**, which is a method of transferring data values from the geophysical line data into the empty grid.

The **Extrapolation Limit** controls the amount of data extrapolation across data gaps and at the grid edges. Leave the default setting as 5.
5 Select the grid refinement parameters

Select the Grid Refinement tab. For this exercise, use Minimum Curvature grid refinement. You do not need to change any of the default parameters in this tab.

Quick review: Minimum Curvature refinement is a smoothing process which INTREPID repeats according to the number of iterations you specify. Each iteration produces a change in some cell values. The changes become smaller with each iteration. When the maximum change for any cell falls below the Maximum Residual or INTREPID has completed the required number of iterations, the Minimum Curvature process stops. In a similar manner, MITRE uses the 3D gradient physics of tensors, to minimize those parts of the observed tensor gradients that are not consistent. Consult the reference manual for an explanation of the other parameters.

6 Select the output grid parameters

Select the Output Grid tab. We want to change the output grid name. To do this choose the Browse button on the far right of the Output File Options. The Output Grid dialog box appears.

The File name albury_rawmag is the default output grid name in the text box, choose Save. The Output Grid name updates to the new name.

Next we want to set the grid cell size. This is really the most important parameter, since it controls the resolution and the size of the output grid. In the Grid Dimensions panel, under Cell size, use the up and down arrows to set the cell size. A good rule of thumb is to set the grid cell size to be 1/4 of the acquisition line spacing for scalar field measurements, not supported by horizontal gradients. This tool has several enhanced gridding methods that make use of horizontal gradients, if you have them, so that the cell size can be taken up to 1/10 the line spacing. To do this systematically, the sign conventions for the observed gradients must be carefully respected. If you don’t know the acquisition line spacing you can measure it using the Flight Path editor or the Visualisation tool. The guided tours introducing these tools each include a line spacing measurement activity (See Visualisation tools(G05). The line spacing for the albury dataset is approximately 200m, so 50m cell size is a safe choice. Enter 50 in the X cell size box, and also press return, to force this to be noticed by the Y cell size box as well. Rectangular, rather than square grids are supported, but rarely used.
7 Proceed with the gridding.

Choose **Apply** in the bottom right hand corner of the Gridding tool window. INTREPID starts gridding the data. A progress popup image shows you the state of the gridding process.

![Progress popup showing gridding process](image)

When the process is finished, an Information box appears telling you that the data has been successfully gridded. Choose **OK**.

![Information box showing successful gridding](image)

8 Exit from the tool.

To exit from the Gridding tool, choose **Exit** from the **File** menu.

**For a better view of your grid**

You can use the Visualisation tool to examine your grid. Recall the instructions in Visualisation tools(G05).

**Key points for this guided tour**

In this guided tour you have used the Gridding tool to create a grid from data stored
in a line dataset
Frequently Asked Questions

Q: How big can my datasets be?
A: The INTREPID Gridding tool supports extremely large grids—the grid size is limited by the hardware and Operating System. The tool offers a tiling system that allows computers of modest size to grid very large datasets.

Q: Can I import or export my favourite grid format?
A: INTREPID IO API grid formats are already compatible with ERMapper, ARC/INFO raster, ZYCOR zmap, GMT, Geosoft formats. The INTREPID Export tool can output your data in a wide range of formats including ASCII, Geosoft, ECS, Geosolutions, GEOPAK, NetCDF, and GA (AGSO) formats.

Q: Does INTREPID support multiband grids?
A: Yes, both the INTREPID Gridding tool and other INTREPID grid processing tools support multiband grids.

Q: Can INTREPID deal with ‘holes’ in the data?
A: Yes. Masking is supported. In fact, close management of extrapolation is a critical success factor in many downstream interpretation tools.

Q: What gridding methods does INTREPID use?
A: The INTREPID Gridding tool has four gridding methods (as shown in the table below) and additional grid refinement procedures. After the gridding process (no matter which method you use), INTREPID can refine your grid using LaPlace smoothing and iterative Minimum Curvature refinement.

<table>
<thead>
<tr>
<th>Method</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nearest Neighbour</td>
<td>General purpose—suitable for all data types. The interpolation process honours original data, which makes this method very accurate. Nearest Neighbour is slower than other methods. It is close to a the Watson Delaunay ideas, except that this is not a necessary condition</td>
</tr>
<tr>
<td>Bi-Cubic Spline (Fast Grid)</td>
<td>This method is restricted to line datasets. It uses Bi-Cubic Spline interpolation to estimate grid values. The method is very fast. Extensions for vector components have been made here.</td>
</tr>
<tr>
<td>Trend Spline</td>
<td>This method uses adaptive directions to ‘follow’ the geological strike of features cutting across survey lines. THIS is no-longer offered</td>
</tr>
<tr>
<td>Box Filter</td>
<td>General purpose—suitable for all data types. The Box Filter method is faster but not as accurate as the Nearest Neighbour method.</td>
</tr>
<tr>
<td>Variable Density</td>
<td>This method is designed to minimise grid artifacts for datasets which have a variable data separation, eg; land gravity, marine gravity and bathymetry data.</td>
</tr>
<tr>
<td>SLERP</td>
<td>This method starts with a nearest neighbour strategy, to identify the 3 nearest observation points to each cell centroid that use wish to estimate a tensor gradient. The SLERP, or spherical linear interpolation method is used to estimate the rotational parts of the signal. This is provided for both Falcon and FTG datasets.</td>
</tr>
</tbody>
</table>
### Refinement methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Curvature</td>
<td>This iterative process smooths the grid points after the initial gridding. It is applied only to interpolated grid values, thus the original data points are honoured.</td>
</tr>
<tr>
<td>MITRE</td>
<td>This iterative process will smooth Full Tensor gradient data.</td>
</tr>
</tbody>
</table>